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ADT773/783/793 SCPI Commands Set

1 Commands Instruction

SCPI means Standard Commands for Programmable Instruments, which defines a set of standard syntax and commands
for controlling programmable instruments. It communicates with the instrument through ASCII string format. A command
generally consists of a series of keywords, some of which also need have parameters. In the protocol, the command is
specified in the following form: * IDN?. In use, it can be the full name or only abbreviations containing uppercase letters.
Usually, instrument commands can be divided into controlling commands and query commands. The controlling commands
donot have return values, its result can be checked by sending the command SYSTem: ERRor?. The query commands have
returned value, and it is also ASCII string.

(1)Format

Each command includes two parts: keyword and parameter, different keywords are separated by a colon "', followed by
optional parameters. If there is a "?" after the command, it indicates it is query command. The keyword and the first parameter
should be separated by a space.

For example:

Command CHANnNell: BWLimit 20M. The first keyword is CHANnel, and the second keyword is BWLimit. The keywords

are separated by ":", with 20M being the parameter and separated from the keywords by space.



‘Additel)

Metrology Made Simple

Query command CHANnell: BWLimit? The question mark "?" indicates a query.
(2)About the symbol
The following symbols are not sent with the command.
a. Vertical line |
A vertical line is used to separate multiple parameters, and one of the parameters must be selected when using the
command.
b. Square brackets []
The content in square brackets can be omitted.
c. Triangle brackets<>
The parameters in the triangle brackets must be replaced with a valid value.
(3)About the abbreviation
All commands are not case sensitive, you can use all uppercase or lowercase. But if you want to abbreviate, you must
enter all uppercase letters in the command format.
For example: CHANnel: Value? Can it be abbreviated as CHAN: Value?
(4) Terminator
The SCPI command must include a command terminator, which can be one of the follows (excluding double quotation

marks): "\r\n", "\r", "\n" or "\0". In some serial communication software, select the option "send line break" means that the
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software will automatically send the command terminator.

2 Commands instruction

2.1 IEEE488.2 common commands

NO. Command Explanation Parameters Returning values Example
This command elminates the following
registers;
a.Standard event register
1 *CLS b.Querying event register - . *CLS
c.Operating event register
d.Status byte rgister
f.Error queue
Device identification query, the returned data
is divided into 4 parts: Send:*IDN?
1. manufacturer Return:
2 *IDN? - Device identification
2. model ADDITEL,,123456789,P25d&MPC
3. product serial number V2.0.0.6
4. device ID and software version
3 *RST Main software reset - - *RST
2.2 Pressure commands
NO. Command Explanation Parameters Returning values Example
PRESsure:MODule:UNIT? Read pressure module units <ModulelD> number of the Pressure unit of the module Send:
L <ModulelD> designated module (1|2|4|6) PRESsure:MODule:UNIT? 1
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1: control module
2:internal high range module
4:external module

6:barometric module

Return:MPa

PRESsure:MODule:UNIT
<ModulelD>,<UNIT>

Set pressure unit of the module

<ModulelD> number of the
designated module (1]|2]|4|6)

1: control module

2: internal high range module

4: external module

6: barometric module

<UNIT>

Below are valid units:

Pa hPa kPa MPa mbar bar
psi  mmH20@4C

cmH20@20C inH20@4C
inH20@20C kgflcm?2 torr
ftH20@4C inH20@20C
inHg@0C mmHg@0C

The list also contains custom unit,
read custom unit by sending

command:

PRESsure:MODule:UNIT:LIST?

None

PRESsure:MODule:UNIT 2,Pa

PRESsure:MODule:UNIT:LIST

?

Read the current pressure unit list

None

the list of current pressure unit
names, including the unit, availability
status, and custom unit status,

Pa&1&0, indicates that the unit is

available and not a custom unit

Send:
PRESsure:MODule:UNIT:LIST?
Return:
Pa&0&0,hPa&1&0,kPa&1&0,MPa
&1&0,psi&1&0,User1&1&1,User2&
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USER1&0&1 indicates that the unit is

not available and is a custom unit

1&1,User3&1&1,User4&1&1,User5
&1&1

PRESsure:MODule:RESOlutio

n? <ModulelD>

Read module resolution

<ModulelD> module number
(11214(6)

1: control module

2: internal high range module
3: internal low range module
4: external module
6:

barometric module

Current resolution

Send:
PRESsure:MODule:RESOlution? 1

Return:5

PRESsure:MODule:RESOlutio

n <ModulelD>,<Value>

Set module resolution

<ModulelD> module number
(112131416)

1: control module

2: internal high range module
3. internal low range module
4: external module

6: barometric module
<Value>

Resolution to be set, valid value 5,6,7

None

PRESsure:MODule:RESOIlution

2,6

PRESsure:MODule:ZERO
<ModulelD>

Zero the module

<ModulelD> module number
(112146)

1: control module

2: internal high range module

4: external module

6: barometric module

None

PRESsure:MODule:ZERO 2

PRESsure:MODule:ZERO:CA
NCel <ModulelD>

Cannel zero the module

<ModulelD> module number
(1/2146)

1: control module

None

PRESsure:MODule:CANCel:ZERO
5
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2: internal high range module
4: external module

6: barometric module

PRESsure:MODule:PTYPe?

Read pressure module pressure

<ModulelD> module number (1]2]4)

The pressure type of current module:

Read internal high range module

8 <ModulelD> type 1: control module G:gauge pressure type
2: internal high range module A:absolute Send:
4: external module D:differential PRESsure:MODule:PTYPe? 2
Return:A
PRESsure:MODule:RANGe? Read the module range <ModulelD> module number The range and unit of the current Read internal module range
o <ModulelD> (2]2]516) module, high and low range is Send:
1: control module separated by “~", unit is out of the PRESsure:MODule:RANGe? 2
2: internal high range module “()". Multiple range is separated by “,” | Return:(0 ~ 25) MPa
4: external module If the multiple ranges are:
6: barometric module 0~70MPa # 0 ~ 25MPa
Send:
PRESsure:MODule:RANGe? 2
Return:(0 ~ 70) MPa,(0 ~ 25) MPa
PRESsure:RANGe:LIST? Read the multiple range list, the None Get a list of current ranges, including | Send:PRESsure:RANGe:LIST?
10.

range index is not start from 0

index (the first digit represents
modules <2 high range module, 3 low
range module, 4 external module>,
second digit represents module
range numbers), ranges, and units.
High and low ranges are separated
by '~', and ranges are separated by

Ty

Return:21,(0 ~ 70) MPa&22,(0 ~
25) MPa
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PRESsure:RANGe:INDEx? Read the range index of the None The index of the current range in the | Send:
1 controller list: PRESsure:RANGe:INDEX?
(the first digit represents modules <2 | Return:21
high range module, 3 low range
module, 4 external module>, second
digit represents module range
numbers, it is not start from 0
PRESsure:RANGe:INDEx Set the range index of the <INDEX> None Set the current range of internal
12. <INDEX> controller The index to be set module as the range of index 0 in
The value should be within the range the list
list: Send:
the first digit represents modules <2 PRESsure:RANGe:INDEx 21
high range module, 3 low range
module, 4 external module>, second
digit represents module range
numbers, it is not start from 0, needs
get the data from the list
PRESsure:MODule:MULTiran Read if the module has multiple <ModulelD> module number 0:single range Read if the internal module has
13 ge? <ModulelD> range (2]2]416) 1:multiple range multiple range
1: control module Send:
2: internal high range module PRESsure::MODule:MULTi:RANG
4: external module e?2
6: barometric module Return:1
PRESsure:RANGe:MODE? Read the current range mode None 0:manual range Send:
14.

1:auto range

PRESsure:RANGe:MODE?

Return:0
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PRESsure:RANGe:MODE Set the current range mode <Mode> Set the range to manual
1 <Mode> 0:manual range Send:
1:auto range PRESsure:RANGe:MODE 0
Return:None
PRESsure:MODule:ONLIne? Read pressure module online <ModulelD> module number 0: module is offline Send:
6. <ModulelD> status (2]2]416) 1: module is online PRESsure:MODule:ONLIne? 2
1: control module Return:1
2: internal high range module
4: external module
6: barometric module
PRESsure:MODule:INFO? Read information of the pressure <ModulelD> module number Module information, separated by Read internal module information
1. <ModulelD> module, which is a comprehensive | (1]2|3]4|6) () Send:
command. If the module has 1: control module <ID> serial number PRESsure:MODule:INFO? 2
multiple ranges, the ranges are 2: internal high range module <Range>range Return:DPSE022480040,(0 ~ 25)
separated by '&' 3: internal low range module <Type>pressure type MPa,G,DPS-EX V00.00.00.15,6
4: external module G:gauge For multiple ranges module,
6: barometric module A:absolute ranges are separated by ‘&'
D:differential Send:
<Version>version PRESsure:MODule:INFO? 2
<Accuracy>accuracy Return:DPSE022480040,(0 ~ 70)
MPa&(0 ~ 25) MPa,G,DPS-EX
Vv00.00.00.15,6
PRESsure:MODule:FILTer? Read module filter information <ModulelD> module number <Enable> 0:0ff, 1:on Read control module’s filter
18.

<ModulelD>

(1121314)
1: control module
2: internal high range module

3: internal low range module

<FilterType> O:first-order filter
1:average filter
<Value>filter parameter:

If FilterType is O, this means the filter

information
Send:
PRESsure:MODule:FILTer? 1

Return:1,0,0.5
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4: external module

coefficient, range is 0-1;
If FilterType is 1, this means the

sampling time, range is 1-20(s);

19.

PRESsure:MODule:FILTer
<ModulelD>,<Enable>,<FilterT

ype>,<Value>

Set module filter information

<ModulelD> module number
(1121314)

1: control module

2: internal high range module

3: internal low range module

4: external module

<Enable> 0:0ff, 1:0n
<FilterType> O:first-order filter
1:average filter

<Value>filter parameter:

If FilterType is O, this means the filter
coefficient, rangeis 0-1;

If FilterType is 1, this means the

sampling time, range is 1-20(s)

Send:
PRESsure:MODule:FILTer
1,1,0,0.5

Return: none

20.

PRESsure:MODUIe:VALUes?

Read pressure value of all the

modules.

When the controller is not
connected to the barometric
module or external module, this bit
is empty, as shown in the following

example

ADT793
<PML>,<Unit>&<PMH>,<Unit>&<Pct
I>,<Unit>&<Pin>,<Unit>&<Acc>,<Uni
t>&<Baro>,<Unit>&<ExtPM>,<Unit>
<PML> internal low range pressure
<PMH?> internal high range pressure
<Pctl> Pctl pressure

<Pin> pump source pressure

<Acc> accumulator pressure

<Baro> barometric module pressure

Send:
PRESsure:MODUIe:VALUes?
Return:
0.86974597,MPa&13326.722,MPa
&0.0018362,MPa&3.075833,MPa
&
2.065,MPa&100.132,MPa&-0.054,
MPa

If external module is not

connected, the value for the
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<ExtPM> external module pressure

ADT773/783
<PML>,<Unit>&<PMH>,<Unit>&<S1
> <Unit>&<S2>,<Unit>&<Baro>,<Uni
t>&<ExtPM>,<Unit>

<PML> internal low range pressure
<PMH?> internal high range pressure
<S1> pressure supply pressure
<S2> vacuum supply pressure
<Baro> barometric pressure

<ExtPM> external module pressure

external module will be
empty(behind the last “,")

For barometric module, it is same.

2.3 Pressure measurement

NO. Command

Explanation

Parameters

Returning values

Example

PRESsure:MODule:MEASure

? <ModulelD>

Read the measured value of the

pressure module

<ModulelD> module number
(112131416)

1: selected module

2: internal high range module
3: internal low range module
4: external module

6: barometric module

Measured value and unit,

separated by “,

Read the measured value of

internal module

Send:
PRESsure:MODule:MEASure?
2

Return:0.566, MPa

2.4 Pressure output

NO. Command

Explanation

Parameters

Returning values

Example

PRESsure?

Read the current output pressure

Pressure value and unit

Send:PRESsure?
Return:0.0003,MPa

10
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PRESsure:MODule:CONTrol?

Read current pressure module

controlling status

The controlling status, one of the
following three:

VENT

MEASURE

CONTROL

Send:
PRESsure:MODule:CONTrol?
Return:VENT

PRESsure:MODule:CONTrol

Set current pressure module

<STATE>: The controlling status,

Set the status to control

<STATE> controlling status one of the following three: Send:
VENT PRESsure:MODule:CONTTrol
MEASURE CONTROL
CONTROL Return:None
PRESsure:MODE? Read pressure module controlling None The controlling status, one of the | Send:

status following three: PRESsure:MODE?
VENT Return:VENT
MEASURE
CONTROL
PRESsure:MODE <STATE> Set pressure module controlling <STATE>: The controlling status, None Set the status of current module to

status

one of the following three:
VENT]|0

MEASURE|1
CONTROL|2

Control

Send: PRESsure:MODE
CONTROL

Return: none

Set the status of current module to
Measure

Send: PRESsure:MODE 1

Return: none

PRESsure:TARGet:RANGe?

Read the range of target value

Low limit, high limit, unit

format:<LOW>,<HIGH>,<UNIT>

Send:
PRESsure:TARGet:RANGe?

Return:0,73.5,MPa

11
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PRESsure:TARGet?

Read the target value

Target value and unit

Send:PRESsure:TARGet?

’ Return:0.10000,MPa
PRESsure:TARGet <Value> Set the target value, note that the <Value>target value Set the target pressure at 100
8 value should within the range Send:PRESsure:TARGet 100
Return:None
PRESsure:RANGe? Read the current range The range index (first digit is the | Send:
o module number: 2 internal high | PRESsure:RANGe?
range, 3 internal low range, 4 | Return:21,(0 ~ 25) MPa
external module; second digit is
range number starts from 1) and
range
PRESsure:MODule? Read the current control module 1: no control module Send:PRESsure:MODule?
0. 2: internal high range Return: 2
3: internal low range
4: external module
PRESsure:MODule Set the control module <ModulelD> module ID(2|3|4) Send:PRESsure:MODule 2
. <ModulelD> 2: internal high range Return: None
3: internal low range
4: external module
PRESsure:Vent? Read the vent pressure Vent pressure Send:PRESsure:Vent?
12 Return: 0.1,MPa
PRESsure:Vent <Value> Set the vent pressure <Value> vent value to be set Send:PRESsure:Vent 0.2
13 Return: None
PRESsure:PLIMit:ENABle? Read the status of setpoint limit Status of setpoint limit Send:
14.

0: disable

1: enable

PRESsure:PLIMit:ENABIe

Return: 0

12
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PRESsure:PLIMit:ENABIe <V | Set the status of setpoint limit <Value> Send:
1> alue> 0: disable PRESsure:PLIMit:ENABIe 1
1: enable Return: None
PRESsure:PLIMit? Read the setpoint limit range Lower limit, upper limit and unit Send:PRESsure:PLIMit?
16. Return: 0.005,70,MPa
PRESsure:PLIMit <Lv>,<Uv> Set the setpoint limit range <Lv> lower limit of the setpoint limit Set the setpoint limit range as
1. Valid only when the returned value of | <Uv> upper limit of the setpoint limit 0.005,70
PRESsure:PLIMit:ENABIle?=1 Send:PRESsure:PLIMit 0.005,70
Return: None
PRESsure:TYPE? Read the current pressure type <Type> pressure type Send:PRESsure:TYPE?
18 G:gauge Return: G,0
A:absolute
<EnableSwitch> switchable
between gauge and absolute or
not?
0: not support
1: support
PRESsure:TYPE <Type> Set the current pressure type. If it <Type> Set pressure type as absolute:
19. doesn’t support switch pressure type, | G: gauge Send:PRESsure:TYPE A
it will return an error. A: absolute Return: None
PRESsure:STEP? Read manual step value Step value Send:PRESsure:STEP?
20 Return: 0.5
PRESsure:STEP <Value> Set manual step value <Value>step value to be set Set step value as 0.5
2t Send:PRESsure:STEP 0.5
Return: None
PRESsure:STEP:UP Perform upward step Send:PRESsure:STEP:UP
22.

13
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Return: None

23.

PRESsure:STEP:DOWN

Perform downward step

Send:PRESsure:STEP:DOWN

Return: None

24.

PRESsure:CONTrol:INFO?

Read current control information

The control information, items are
separated by (,)

<Value> real time pressure value
<Target> target value

<Unit> unit

<Range> range

<Type> pressure type

G: gauge

A: absolute

D: differential

<IsStable> stabilized or not

0: not stabilized

1: stabilized

<State>control status

VENT

MEASURE

CONTROL

<ExtendInfo> extend ports
information

one byte data lenfth, indicates 8 IO
statuses, as below:

bit7~0:

CPS, DRV1, DRV2, DO1,D0O2,
D03, DC24, Switch

Send:
PRESsure:CONTrol:INFO?
Return:0.0267,2.0,MPa,(0 ~
MPa,G,0,MEASURE,30

25)

14
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PRESsure:CONTrol:MODE? Read control mode Control mode Send:
2. 0: fast PRESsure:CONTrol:MODE?
1: standard Return: 0
2: custom
PRESsure:CONTrol:MODE Set control mode <Value> Send:
26. <Value> 0: fast PRESsure:CONTrol:MODE 1
1: standard Return: None
2: custom
PRESsure:CONTrol:SLEWrate | Read control slew rate <type> ,<value>,<unit> 1 read slew rate, no limit
27 ? <type>: slew rate type; O=unlimited | Send:
1=limited PRESsure:CONTrol:SLEWrate?
<value>: slew rate value; When the | Return: 0,MAX,MPa
type is 0 without limit, the value is | 2 Read slew rate, the limit value is
MAX, and when the slew rate is 1, | 5MPa
the limit value will be returned Send:
<unit>: Unit of slew rate PRESsure:CONTrol:SLEWrate?
Return:1,5,MPa
PRESsure:CONTrol:SLEWrate | Set slew rate as unlimited, only Send:
28 ‘MAX available when control mode is PRESsure:CONTrol:SLEWrate:MA
custom X
Return: None
PRESsure:CONTrol:SLEWrate | Set a slew rate value, the unit is <Value>: slew rate value Send:
29. :LIMIt <Value> current pressure unit, only available PRESsure:CONTrol:SLEWrate:LI
when control mode is custom MIt 5
Return: None
PRESsure:CONTrol:STABIlity? | Read stability setting <type>,<value>,<unit>,<valuePerc | Send:
30.

ent>,<unitPercent>,<second>

PRESsure:CONTrol:STABIlity?

15
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<type>:stability setting, O
percentage, 1 stability value
<value>: when type=0, it is
percentage; when type=1, it is
stability value

<unit>: when type=0, it is %FS,
when type=1, it is stability value
<valuePercent>:percentage value
<unitPercent>: percentage value
unit

<second> stability time

Return: 0,0,kPa,0.003,%FS,2

31.

PRESsure:CONTrol:STABIlity

<type>,<value>,<second>

Set stability, only available when

control mode is custom

<type>:stability setting, O percentage,
1 stability value

<value>: when type=0, it is
percentage; when type=1, it is
stability value

<second> stability time

PRESsure:CONTrol:STABIlity
0,0.05,30

32.

PRESsure:CONTrol:HEIGht:C

ORRection?

Read head correction information

<Enable> 0:0ff, 1:on

<UnitType> O:imperial 1:metric
<Height>head correction, metric unit
(cm), imperial unit (in)
<Density>media density, metric unit
(kg/m3), imperial unit (Ib/ft3)
<Gravity>gravity acceleration metric
unit (m/s?), imperial unit (ft/s?)

<Temp>temperature, unit is C

Send:
PRESsure:MODule:HEIGht: CORR
ection?

Return:0,1,10,1.293,9.8,25

16
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PRESsure:CONTrol:HEIGht:C

Set head correction information

<Enable> 0:0ff, 1:on

PRESsure:CONTrol:HEIGht: COR

. ORRection <UnitType> O:imperial 1:metric Rection 0,1,10,1.293,9.8,25
<Enable>,<UnitType>,<Height <Height>head correction, metric unit
> <Density>,<Gravity>,<Temp (cm), imperial unit (in)
> <Density>media density, metric unit
(kg/m3), imperial unit (Ib/ft3)
<Gravity>gravity acceleration metric
unit (m/s?), imperial unit (ft/s?)
<Temp>temperature, unit is C
PRESsure:CONTrol: TARE? Read tare information <Enable><Enable> 0:0ff, 1:on Read internal high range module
34 <Value> tare value tare value:
Send:
PRESsure:MODule:TARE?
Return:0,0
PRESsure:CONTrol: TARE Set tare information of designated <Enable><Enable> 0:0off, 1:0n PRESsure:MODule:TARE 1,1
. <Enable>,<Tare> module <Value> tare value to be set
PRESsure:SWITch:TYPE? Read pressure switch type 0: mechanical 1:NPN 2:PNP PRESsure:SWITch: TYPE?
36.
PRESsure:SWITch:TYPE Set pressure switch type 0: mechanical 1:NPN 2:PNP PRESsure:SWITch: TYPE 1
3 <value>
PRESsure:SWITch:VALUe? Read pressure switch action value Close value, pressure unit & open | Send:
3. value, pressure unit PRESsure:SWITch:VALUe?
Return: 20,MPa&18,MPa
PRESsure:SWITch:VALUe:RE | Reset pressure switch action value PRESsure:SWITch:VALUe:RESEt
¥ sm
PRESsure:EXTEnd:INTErface | Read extend interface status CPS,DRV1,DRV2,D01,D02,D03, | Send:
40.

:STATe?

DC24,Switch

PRESsure:EXTEnd:INTErface:ST

17
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0 inactivated

ATe?

1 activated Return:  1,0,0,0,0,0,1,0
PRESsure:EXTEnd:INTErface | Read extend interface output mode <type> <mode>&<model>,<mode2>,<mo | Send:
4L :MODE? <type> 0:CPS de3> PRESsure:EXTEnd:INTErface:MO
1:DVR1 Returns a list of current output DE? 0
2:DVR2 mode and available output modes, Return:  1&0,1
3:D01 current output mode and available
4:D02 output mode are separated by the
5:D03 “&", and different available output
modes are separated by a comma,;
List of output modes:
0:manual
1:CPS
2:vacuum pump
3:pressure pump
4:remote mode
5: status mode
PRESsure:EXTEnd:INTErface | Set extend interface output mode <type> Set CPS manual output
42 :MODE <type>,<mode> 0:CPS Send:
1:DVR1 PRESsure:EXTEnd:INTErface:MO
2:DVR2 DE 0,0
3:DO1
4:D0O2
5:D0O3
<mode>
0:manual
1:CPS

18
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2:vacuum pump
3:pressure pump
4:remote mode

5: status mode

PRESsure:EXTEnd:INTErface | Set extend interface remote mode in | <type> Set DVR1 remote mode status
43 :Remote <type>,<value> on or off 1:DVR1 Send:
2:DVR2 PRESsure:EXTEnd:INTErface:Re
<value> mote 1,1
0:off
1l:on
PRESsure:AZER0? Read auto zero status 0: off Send:PRESsure:AZERo0?
. 1:on Return: 1
PRESsure:AZERo <value> Set auto zero status 0: off PRESsure:AZERo1
5 1:on
PRESsure:ZERO:POINt:STRA | Read zero point control strategy 0 vent Send:
46 tegy? 1 control PRESsure:ZERO:POINt:STRAtegy
?
Return: 1
PRESsure:ZERO:POINt:STRA | Set zero point control strategy <value>: PRESsure:ZERO:POINt:STRAtegy
4. tegy <value> 0 vent 1
1 control
PRESsure:STABle? Read pressure stability status None 0= not stable Send: PRESsure:STABle?
8 1= stable Return: 1
PRESsure:FIXEd:ATM Set fixed ATM pressure value <value> ATM value, (60~120) kPa.a None PRESsure:FIXEd:ATM 100
49.

<value>

19
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2.5 Interface

NO. Command Explanation Parameters Returning values Example
Return to home menu. When using
L this command, please make sure the
SYSTem:HOME
unit is idle without running any task or
test.
0: unlocked Send:SYSTem:LOCK?
2. SYSTem:LOCK? Read the screen lock status
1: locked Return: 1
<State> set screen lock or unlock Set the screen as locked
3 SYSTem:LOCK <State> Set the screen lock status 0: unlocked Send:SYSTem:LOCK 1
1: locked Return: None
2.6 Communication
NO. Command Explanation Parameters Returning values Example
SYSTem:WLAN:STATe? Read WLAN status 0:off Send:
L 1:on SYSTem:WLAN:STATe?
Return: 1
SYSTem:WLAN:STATe Set WLAN status <State> Set WLAN as off
z <State> 0:off Send:
1l:on SYSTem:WLAN:STATe 0
Return: None
SYSTem:WLAN:ADDRess? Read WLAN IP address WLAN IP address Send:
3 SYSTem:WLAN:ADDRess?
Return: 192.168.61.127
SYSTem:WLAN:ADDRess Set WLAN IP address, available only | <IP> Send: SYSTem:WLAN:ADDRess
“ <IP> when DHCP is off. IP address 192.168.1.23

20
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Return: None

SYSTem:WLAN:MASK? Read WLAN IP subnet mask WLAN IP subnet mask Send:
> SYSTem:WLAN:MASK?
Return: 255.255.254.0
SYSTem:WLAN:MASK Set WLAN IP subnet mask, available | <State>
° <Mask> only when DHCP is off WLAN IP subnet mask
SYSTem:WLAN:GATeway? Read WLAN gateway address WLAN gateway address Send:
. SYSTem:WLAN:GATeway?
Return: 192.168.60.1
SYSTem:WLAN:GATeway Set WLAN gateway address <Gateway> Send:
8 <Gateway> WLAN gateway address SYSTem:WLAN:GATeway
192.168.60.1
Return: None
SYSTem:WLAN:DHCP? Read WLAN DHCP status 0:off Send:SYSTem:WLAN:DHCP?
o 1:on Return: 1
SYSTem:WLAN:DHCP Set WLAN DHCP status <DHCP> Send:SYSTem:WLAN:DHCP 0
R T WLAN DHCP status Return: None
0:off
1l:on
SYSTem:WLAN:MAC? Read WLAN MAC address MAC address Send:SYSTem:WLAN:MAC?
1 Return:00:C1:40:76:10:99
SYSTem:WLAN:SSID? Read WLAN SSID <ALL> Optional: The WLAN SSID currently Send:SYSTem:WLAN:SSID?
12.

[<ALL>]

If use ALL, it returns all connectable
hotspot names
If no parameter: it returns the name

of the hotspot that is currently

connected, or all connectable

hotspot names

Return: ConST
If wifi is not connected, adding the
'ALL' parameter and it will return the

list of wifi hotspots, separated by ',". If
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connected
When there is no connection, and

does not return when connected

wifi is connected, the parameter will
be ignored and the current connected
wifi name will be returned.
Send:SYSTem:WLAN:SSID? ALL
Return:
ConST,ESP_844851,CONSTRD,RD
TEST,ESP_627851

SYSTem:WLAN:CONNect Connect with hotspot <Name> Send:
13 <Name>,[<Pswd>] Hotspot name SYSTem:WLAN:CONNect
<Pswd> ConST,123456789
Hotspot password, optional, if no Return:
password or the hotspot was if no password or the hotspot was
connected before, this parameter can connected before, then:
be ignored. Send:
SYSTem:WLAN:CONNect ConST
Return: None
SYSTem:WLAN:DISConnect Disconnect with hotspot
14.
SYSTem:ETHernet:ADDRess? | Read Ethernet IP address Ethernet IP address SYSTem:ETHernet: ADDRess?
15.
SYSTem:ETHernet:ADDRess Set Ethernet IP address. If the IP <IP> Set Ethernet IP address as
1e. <IP> address to be set is the IP address of IP address 192.168.1.23
the network currently connected to Send:

the SCPI, it will cause the SCPI to
disconnect, and connecting again
requires configuring a new IP

address

SYSTem:ETHernet: ADDRess
192.168.1.23

Return: None
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SYSTem:ETHernet:MASK? Read Ethernet subnet mask Ethernet subnet mask Send:
1 SYSTem:ETHermnet: MASK?
Return: 255.255.254.0
SYSTem:ETHernet:MASK Set Ethernet subnet mask <Mask> Send:
18 <Mask> Ethernet subnet mask to be set SYSTem:ETHernet:MASK
255.255.254.0
Return: None
SYSTem:ETHernet:GATeway? | Read Ethernet gateway address Ethernet gateway address Send:
19 SYSTem:ETHernet: GATeway?
Return: 192.168.40.1
SYSTem:ETHernet: GATeway Set Ethernet gateway address <Gateway> Send:
20. <Gateway> Ethernet gateway address to be set SYSTem:ETHernet:GATeway
192.168.40.1
Return: None
SYSTem:ETHernet:DHCP? Read Ethernet DHCP status 0:off
2 1:on
SYSTem:ETHernet:DHCP Set Ethernet DHCP status < DHCP > Send:
2| pHep> 0:0ff SYSTem:ETHermet:DHCP 0
l:on Return: None
SYSTem:ETHernet:MAC? Read Ethernet MAC address Ethernet MAC address Send:
23.

SYSTem:ETHernet:MAC?
Return:

00:07:32:A9:ED:CF
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SYSTem:RS232:Info?

Read RS232 communication

The current RS232 parameters,

Send:SYSTem:RS232:Info?

24. information separated by “,” Return:9600,8,0ne,None
<BaudRate>values can be
9600/19200/38400/57600/115200
<DataBits> 5/6/7/8
<StopBits> None, One,Two,
OnePointFive
<Parity>parity bit
None
Odd
Even
Mark
SYSTem:RS232:Info Set RS232 communication <BaudRate>values can be Send:SYSTem:RS232:Info
25. <BaudRate>,<DataBits>,<Sto information 9600/19200/38400/57600/115200 115200,8,0ne,None
pBits>,<Parity> <DataBits> 5/6/7/8 Return:None
<StopBits> None, One,Two,
OnePointFive
<Parity>parity bit
None, Odd, Even, Mark
2.7 System Commands
No. Command Explanation Parameters Returning values Example
Send: SYSTem:TIME?
1. SYSTem:TIME? Read system time None Hour, minute, second
Return: 2023,1,30
<Hour> SYSTem:TIME 15,05,12
2. SYSTem:TIME
Set system time <Minute> None
<Hour>,<Minute>,<Second>
<Second>
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Read system date

Send: SYSTem:DATE?

3. SYSTem:DATE? None Year, month, day
Return: 2023,1,30
<Year> SYSTem:DATE 2023,01,30
4. SYSTem:DATE
Set system date <Month> None
<Year>,<Month>,<Day>
<Day>
<Format> Send: SYSTem:TIME:FORMat?
5.
SYSTem:TIME:FORMat? Read system time format None 0: 12-hour clock Return: 1
1: 24-hour clock
<Format> SYSTem:TIME:FORMat O
6. SYSTem:TIME:FORMat
Set system time format 0: 12-hour clock None
<Format>
1: 24-hour clock
1:yyyy/MM/dd
7.
SYSTem:DATE:FORMat? Read system date format None 2:MM/ddlyyyy
3:dd/MM/yyyy
<Value> SYSTem:DATE:FORMat 2
8.
SYSTem:DATE:FORMat 1:yyyy/MM/dd
Set system date format None
<Value> 2:MM/ddlyyyy
3:dd/MM/yyyy
Send: SYSTem:DATE:SEParator?
0. SYSTem:DATE:SEParator? Read date separator None R L
Return: /
<Value> SYSTem:DATE:SEParator 2
10.
SYSTem:DATE:SEParator<Va 1:-
Set date separator None
lue> 2:/
3.
Read system volume percentage,
11. SYSTem:VOLUme? None Volume percentage

0-100
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Set system volume percentage,

12. SYSTem:VOLUme <Value> <Value> 0-100 None
0-100
0: disabled
13. SYSTem:VOLUme: TOUCH? Read the touch tone status None
1: enabled
SYSTem:VOLUme: TOUCH 0: disabled
14. Set the touch tone status None
<Value> 1: enabled
0: disabled
15. SYSTem:VOLUme:PROMpt? Read system prompt tone status None
1: enabled
SYSTem:VOLUme:PROMpt 0: disabled SYSTem:VOLUme:PROMpt 0
16. Set system prompt tone status None
<Value> 1: enabled
SYSTem:VOLUme:OVERrang 0: disabled
17. Read system overrange tone status None
e? 1: enabled
SYSTem:VOLUme:OVERrang 0: disabled SYSTem:VOLUme:OVERrange 1
18. Set system overrange tone status None
e <Value> 1: enabled
19 SYSTem:BRIGhtness? Read system brightness None Brightness value 10-100
20 SYSTem:BRIGhtness <Value> | Set system brightness Brightness value 10-100 None SYSTem:BRIGhtness 80
<module> Read host version:
21.
APPLication: host version Send: SYSTem:VERSion?
CONTroller:FIRMware: controller APPLication
firmware version; Return: vV0.0.0.2
SYSTem:VERSion? <module> | Read system version CONTroller:HARDware: controller Version

hardware version;
MODUle<Index>:FIRMware:
pressure module firmware version

<Index> =(2|3|4|6)
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2: internal high range module
3: internal low range module
4: external module

6: barometric module

Read the current language type None zh-CN: Simplified Chinese
22.
SYSTem:LANGuage? zh-TW: traditional Chinese
en-US: English
zh-CN: Simplified Chinese SYSTem:LANGuage en-US
23, SYSTem:LANGuage
Set the current language zh-TW: traditional Chinese None
<Language>
en-US: English
<Medium>
24,
0: gas
PRESsure:MEDIum:NAME? Read the pressure medium type None
1: water
2: oil
<Medium> PRESsure:MEDIum:NAME 0
25.
PRESsure:MEDIum:NAME 0: gas
Set the pressure medium type None
<Medium> 1: water
2: oil
2.8 Electrical Commands
No. Command Explanation Parameters Returning values Example
1: 22mA Send: MEASure:FUNCtion?
1.
Read the current electrical No value= current channel 2: 22mA&24V Return: 2
MEASure:FUNCtion? [<ALL>]
measurement channel ALL= all available channels 3: 10V Send: MEASure:FUNCtion? ALL
4: 1V Return: 1&2&3&4
Set the current electrical <Switch> Set the current channel to 10V
2. MEASure:FUNCtion <Switch> None
measurement channel 1: 22mA Send: MEASure:FUNCtion 3
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2: 22mA&24V

3: 10V

4: 1V

<Switch> Read the resolution of 10V channel

1: 22mA Send:
MEASure:CONFig:RESOIlution | Read the resolution of designated

2: 22mA&24V The resolution value MEASure:CONFig:RESOlution? 3
? <Switch> electrical channel

3: 10V Return: 6

4: 1V

<Switch> Set the 10V channel resolution to 6

1: 22mA Send:
MEASure:CONFig:RESOIution | Set the resolution of designated 2: 22mA&24V MEASure:CONFig:RESOlution 3,6

None

<Switch>,<digital> electrical channel 3: 10V

4: 1V

<digital>resolution: 5, 6, 7

Read the measured value of current

The measured value of current

Send: MEASure?

MEASure? None

channel channel Return: 0.056
MEASure:ZERO Zero current channel None None
MEASure:ZERO:CANCel Cancel zero the current channel None None
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Appendix 1: SCPI unit Id list

Unit Id Unit
2000 Text unit
32767 Space unit
1211 mA
1212 MA

1209 A

1240 \%

1241 mV
1281 Q

1284 kQ

1283 MQ
1000 K

1001 °C

1002 °F

1003 °R
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999 °Re
1005 °
1342 %
1133 kPa
1130 Pa
1131 GPa
1132 MPa
1134 mPa
1135 uPa
1136 hPa
1137 bar
1138 mbar
1139 torr
1140 atm
1141 psi
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1142 psia

1143 psig

1144 gf/cm?

1145 kgflcm?

1147 inH20@4°C
1148 inH20@68°F
1150 mmH20@4°C
1151 mmH20@20°C
1153 ftH20@4°C
1154 ftH20@68°F
1156 inHg@0°C
1158 mmHg@0°C
2001 mtorr

2002 lb/ft?

2003 tsi

2004 psf
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2005 inH20@60°F
2006 ftH20@60°F
2007 cmH20@4°C
2008 mH20@4°C
2009 cmHg@0°C
2010 mHg@0°C
2011 kgfim?

32



Additel)

Metrology Made Simple

Appendix 2: Error definition

NO. Error code Error description Explanation
1 0 No error No error
Command error
2 120 Commandparameter error Command parameter error
3 -108 Parameter not allowed Too many parameter or misuse parameter in commands which do not need the parameter
4 -109 Missing parameter Missing parameter
5 -110 Command header error Command header error
6 -114 Header suffix out of range Header suffix out of range
7 -123 Numeric overflow 43 Numeric overflow, the abs of number’s index is over 43
8 -151 Invalid string data Invalid string data, such as unmatched quote
9 -171 Invalid expression Invalid expression, such as unmatched brackets
Execution error
10 -200 Execution error Execution error
11 -221 Settings conflict Settings conflict
12 -222 Data out of range Parameter out of valid range
13 -223 Too much data Too much data to be processed
14 -224 lllegal parameter value lllegal parameter value
15 -230 Data corrupt or stale The data is invalid, or the data is being read, and valid data has not been obtained
16 -240 Hardware error Hardware error
17 -256 File name not found File name not found
18 -282 lllegal program name lllegal program name
19 220 Measure error Measure error
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NO. Error code Error description Explanation

20 221 Failed to set meaure function Failed to set meaure function

21 222 Failed to read measure value Failed to read measure value

22 223

23 224

24 240 Control error Control error

25 241

26 242

27 243

28 260 Calibration error Calibration error

29 261 Calibration secured Device is secured, cannot perform calibration

30 262 Invalid calibration secure code Invalid calibration secure code

31 263 Missing calibration value This error occurs when the calibration value is set without setting the calibration point
during current/voltage calibration

32 264 Missing calibration data This error occurs when calibration points are set continuously without calibration values set

33 265 Failed to set calibration function Failed to set calibration function

34 266 Calibration data is not enough When saving the calibration data, this error occurs if the calibration data does not reach 3
points

35 271 Setion_name_not_found Setion name not found

36 272 Key_name_not_found Key name not found

37 291 Update secured Update secured, cannot update the device

38 292 Invalid update secure code Invalid update secure code

39 293 Not found the service pack Not found the service pack

40 294 The service pack unavailable The service pack unavailable

41 295 AppUpdate not found AppUpdate.exe not found

Device related errors
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NO. Error code Error description Explanation

42 -310 System error System error

43 -311 Memory error Memory error

44 -350 Queue overflow Queue overflow

45 -360 Communication error Communication error

46 301 Internal module is not connected Internal module is not connected

47 302 External module is not connected External module is not connected

48 303 Supply module is not connected Supply module is not connected

49 304 Vacuum module is not connected Vacuum module is not connected

50 361 Open WLAN Failed Open WLAN Failed

51 362 Set WLAN address mode failed Set WLAN address mode failed

52 363 Set WLAN address failed Set WLAN address failed

53 364 Communication port to WIFI module is not | Communication port to WIFI module is not open
open

54 365 WLANisnotconnected WLAN is not connected
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